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Introduction 

What is Send-it? 

Send-it is a software module within the Polkadots workflow which is designed for remote job 
submission, e-proofing and job approval. It gives external customers or suppliers the ability to 
submit files directly to a RIP for preflighting and RIPping. It also allows them to remotely 
softproof their rasterized pages and approve/reject their own jobs. 

Once pages have been approved by external customers, they are paired up and made into plates 
according to publication and template specs specified by an internal NEWSflo Operator. All jobs 
submitted by external suppliers via Send-it will be visible to internal operators (i.e. company with 
plates & printing press). They will also be able to softproof them, if they wish, before plating and 
outputting the jobs. 

Training videos 

To help you get started, there are some Training Videos that give you a quick visual overview, for 
example: 

• Uploading & softproofing pages 

• How to install PrePage-it Upload 
 
Please consult your Polkadots Software dealer or view them directly from the Polkadots web site 
http://www.polkadots.ca/support/training_videos.asp. 

http://www.polkadots.ca/support/training_videos.asp�
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Send-it Basics 

This chapter covers everything an external customer/supplier needs to know about Send-it. You 
will find basic, practical explanations and procedures regarding how to use Send-it. 

External customers/suppliers log on to Send-it with Super-User or User accounts (see External 
User Accounts on p.21 for more information about Send-it accounts). 

What can external customers / suppliers do with Send-it? 
• submit jobs to be pre-flighted and RIPped 

• see list of RIPped jobs 

• view softproofs: low-res Previews, PDF softproofs (optional), and View-it hi-res softproofs 
(optional) 

• approve/flush pages & jobs 

• write and read annotation comments in a View-it softproof 

• receive e-mail notifications of events (e.g. approved jobs, errors) 
 

Launching Send-it 

Note 

Send-it Clients can be launched from any workstation equipped with one of the 
following operating systems: Win XP Pro (or higher), Mac OS 10.4 (or higher). 

Send-it Clients can be opened in any web browser on any workstation by: 

1. Typing the IP address or URL of the Send-it Server. 
2. Logging on with your Send-it Login username/password. 
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IP address 

An external customer/supplier must use the external, public IP address or URL of the Send-it 
Server (add port number if other than port 80). 

Internal operators should use the internal, private IP address or URL of the Send-it Server (add 
port number if other than port 80). 

Web browsers 

Minimum requirements: 

• Firefox 2 or 3 (Mac or PC) 

• Internet Explorer 7 (PC) 

• Safari v.3 (Mac OS 10.4 or higher) 
 
Browser tips 

• it is recommended to use recent versions of web browsers, as listed in the previous section 

• avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.) 

• pop-up blockers can prevent some Send-it windows from being displayed 

• if portions of the Send-it interface are displayed incorrectly or missing: 

Type IP address 
or URL of the 
Send-it Server. 

Type your Login 
username and Password. 
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 try to reload/refresh the web page using the web browser’s Reload or Refresh 
command 

 try clearing the web browser’s cache or temporary internet files 

 see the section Troubleshooting Tips on p.25 for details 
 

How to submit job pages - Overview 
The procedure below describes how to create a job with Send-it, including how to upload, 
softproof, and approve/reject job files. 

Create a job name 

1. Click the Jobs link, then click the New button to create a new job name/folder. 

 

 

 

 

Give a Job name. 

Select the job’s Owner 
(by default this is the user 
who creates the job). 
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Tip 

If a user creates a job and wants that job to be visible to all other users in their user 
group, then they should check the box Make this job visible for the entire group. 

The new job will be listed in the Job List. 

 

 
Single Pages 

1. Upload pages in one of the following ways: 
 

Method A: PrePage-it Upload: (see Uploading Files on p.11 for a detailed explanation) 

Log on to PrePage-it Upload, select the new job folder you just created, then select a suitable 
Pages queue. Finally drag and drop the page files you want preflighted and RIPped, then 
click the Upload button. 
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Method B: PrePage-it Printer: (see Uploading Files on p.11 for a detailed explanation) 

Log on to PrePage-it Upload, select the new job folder you just created, then select a suitable 
Pages queue (see previous figure). Next, print a job file from any Mac or PC application, 
selecting ToPrePageitServer as the printer. Finally, go back to the PrePage-it Upload window 
and click the Upload button. 

 

 
Method C: Web Interface: 

Click on the link of the new job you just created, then click the Pages link. Now upload a 
page from the File Upload panel so it can be preflighted and RIPped. 

Select Job folder where 
file will be placed. 

Drag n drop job files. 

Select Queue where 
files will be RIPped. 

Print using 
ToPrePageitServer. 

Click Upload 
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2. Softproof single pages from the Pages tab in one of the following formats: 

a low-res Preview 
b med-res PDF (optional - click PDF icon  if available) 
c hi-res View-it softproof (optional – click View-it link if available) 

 

 

  

 
3. Approve pages / jobs in the following way: 

 If you are set up with page approval, then select one or more pages and click the 
Approve button from the Pages window. 
  or   

a. Select a file (click Browse). 

b. Select a PAGES queue 
(Preflight profile). 

c. Click Send-it button. 

Preview (low-res softproof) 

View-it (hi-res softproof) 

PDF ROOM Proof (med-res single-page softproof) 
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 If you are set up with job approval, then when all pages are ok, Approve the whole job 
from the Job List window. 
  or   

 If a page or job is not good, you can Delete selected page(s) or Flush the entire job. 
 

 

 

 

 

Note 

Send-it approval may be configured on a per-job or per-page basis. If you are set up 
with page approval, then rather than approving the entire job, you must approve 
individual pages – you will not have the option of approving the entire job as shown 
in the figure above. 

Approve selected page(s). 

Approve entire job. 

Delete selected page(s). 

Flush (delete) entire job. 
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Tip 

As an alternative, a page may also be approved from within the View-it softproof 
window. 

Important 

When the terms Flush / Reject / Delete are used in reference to a page or job, they all 
have the same meaning i.e. the RIPped files will actually be deleted from the hard 
disk. 

Uploading Files 
The general procedure for submitting a job is outlined in the section How to submit job pages - 
Overview, starting on p.6. This section explains the specifics about how to install the PrePage-it 
Upload and PrePage-it Printer and how to use these tools to upload files. 

Uploading Overview 

In Send-it there are currently three methods for submitting job files to the RIP: 

• Web Interface’s File Upload (Pages tab) 

• PrePage-it Upload utility 

• PrePage-it Printer (ToPrePageitServer) 
 

Note 

The Java applet that was used for uploading files in prior versions has been replaced 
by the PrePage-it Upload utility. 

The terms submitting/uploading/printing files here all refer to the same thing: submitting job 
files to a PrePage-it RIP queue in order to be processed i.e. preflighted, rasterized, etc. 

Web Interface 

The File Upload panel within the Pages tab of the web interface allows you to submit job files 
directly from the web interface (see figure below). However it is disadvantaged by the fact that 
you can only upload one file at a time. 
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PrePage-it Upload & Printer 

Two other methods exist for submitting jobs: PrePage-it Upload and PrePage-it Printer. These are 
separate, external utilities that can be used without logging on to Send-it. PrePage-it Upload allows 
you to submit PS or PDF jobs by dragging and dropping them unto the PrePage-it Upload 
window. The PrePage-it Printer utility creates a printer called ToPrePageitServer, which you can use to 
print jobs to RIP queues from any application. These tools can be installed and used on Mac or 
PC workstations. 

PrePage-it Upload/Printer provide more convenient ways of submitting jobs. PrePage-it Upload allows 
you to drag multiple job files unto the PrePage-it Upload window. The PrePage-it Printer allows you 
to print jobs in the intuitive manner that many operators are used to doing. 

Note 

The PrePage-it Upload and PrePage-it Printer tools can be used on Windows XP Pro (or higher) 
and Mac OS 10.4 (or higher). 

Installing PrePage-it Upload & Printer 

The PrePage-it Upload Setup is an installer which installs both the PrePage-it Upload and PrePage-it Printer 
tools. It must be installed on each workstation where these tools will be used. There are two 
installers – one for Mac (zip) and one for PC (exe). 

  

a. Select a file (click Browse). 

b. Select a PAGES queue 
(Preflight profile). 

c. Click Send-it button. 
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These installers can be downloaded either from the Send-it Login screen by clicking the link 
Click here to install Prepage-it Upload or from the Send-it File Upload panel by clicking the link 
Or try Prepage-it Upload. 

  

To install: 

1. Launch the PrePage-it Upload Setup and follow the instructions provided. 

Warning 

When PrePage-it Upload is installed on a Mac OS X 10.5, a security feature prevents the 
PrePage-it Printer from being created. Therefore this security feature must be disabled in 
the Mac OS X System Preferences before running the PrePage-it Upload Setup. A detailed 
account of this topic can be found in the tech note PrePage-it Upload & Mac OS 10.5. 

2. When prompted with the following window, you should provide the Send-it Host 
information i.e. the IP address or URL of the server machine. 
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Note 

For external customers/suppliers who install PrePage-it Upload, the Send-it Host 
information must be the external, public IP address or URL of the server machine. 
Internal operators must provide the internal, private IP address or URL of the 
Send-it server. 

3. The Port and Printer Service settings can usually be left at their defaults. If you need to 
change them, you may do so at this point. Note that if the port used by your Send-it 
server is different from the default port 80, then it is important to specify the correct Port 
setting here. 

 
After a successful installation, you will see two items added: the PrePage-it Upload application (on 
the Windows Desktop or the Mac Applications folder) and a printer called ToPrePageitServer. 

   

 

Specify Host information of Send-it server: 
-external/public IP address (external customers/suppliers) 
or 
-internal/private IP address (internal operators) 

Keep default settings for Port and Printer unless your 
Send-it server has a custom port (other than 80). 
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Submitting jobs with PrePage-it Upload & Printer 

The following procedure outlines how to submit jobs via the PrePage-it Upload or PrePage Printer. 
This single procedure describes both tools. 

1. Launch the PrePage-it Upload application and log in with your Send-it account. If necessary, 
click the Server arrow and select your server. 

 

2. In the PrePage-it Upload window shown below, specify the Job and Queue where you want 
to submit a file. If necessary, create a new Job folder by clicking File > Add Job or by 
clicking the Add Job icon. 

Note 

The Job folder and Queue that you select here applies whether you drag and drop files 
onto the PrePage-it Upload window or print them using the PrePage-it Printer. 
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Tip 

In a typical workflow setup, the PrePage-it Upload application window should always 
be kept open when you are submitting jobs, whether by drag n drop or by printing. If 
it’s closed, you will be automatically prompted to log on to PrePage-it Upload after 
you've submitted a file via the PrePage-it Printer. 

3. Drag and drop: If you want to drag and drop PS or PDF files, drag them unto the 
PrePage-it Upload window (figure above). 

-or- 

Print: To print a file from an application, select the ToPrePageitServer printer when printing 
from your application (figure below). 

Select Job folder where 
file will be placed. 

Drag n drop job files. 

Select Queue where 
files will be RIPped. 

Click Upload 

If necessary, click the 
Add Job icon to create 
a new Job folder. 
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4. When all files appear in the PrePage-it Upload window, regardless how they were 

submitted, click the Upload button. 

 

 

Tip 

To automatically open the Send-it window, click the Show Web Entry button. 

Queues (Preflight profiles) 
Queues, or Preflight profiles, determine how pages are preflighted and RIPped after they’re 
uploaded. Send-it lists two types of queues: Pages (Normalize) and Upload Only. 

Print using 
ToPrePageitServer 

Click Show Web Entry 
to open Send-it interface. 

Click Upload to 
submit listed files. 
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In this section we explain the difference between these two types of queues. 

Pages (Normalize) queues 

 

These queues preflight and process single-pages, RIPping them into rasterized, contone pages. 
As a result, all pages are “normalized” into a uniform, standard file type. 

Typically, pages are processed through one of these queues: 

• NORM_PAGES_CMYK → forces a page to CMYK (4 plates max.) 

• NORM_PAGES_K → forces a page to the black plate (1 plate max.) 

• NORM_PAGES_SPOT → preserves all plate colors (process + spots) in a page 
 
Upload Only 

 

The Upload Only queue provides a way of exchanging files between Users/Super-users (external 
suppliers/customers) and Operators (internal company). Similar to an FTP Client, it can be used to 
upload and download files between a company and its suppliers. Anyone with a Send-it account 
can upload any type of file. This means that not only can users transfer PS or PDF jobs, but also 
files that cannot be sent directly to a RIP e.g. native Quark/InDesign/text files. 

 

 

 

When a job is submitted to the Upload Only queue, it will appear in the Notes panel of the Pages 
tab (see figure above). Once it is listed in the Notes panel of a job, any operator or user who has 
access to that particular job can download a copy of the file to their workstation. 

 clicking Download allows you to save the file on your hard disk 

 the file will remain in the Notes panel until it is deleted by putting a checkmark next to 
the file and then clicking the Delete link 

PDF that has been uploaded 
via Upload Only queue. 

Click download to save a copy of 
the PDF on your workstation. 
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If a file is submitted with PrePage-it Upload, the Job folder as well as the queue Pages:Upload Only 
must be specified. 

 

 

 

 
 

Viewing Tools 
View-it 

View-it is an optional module. 

View-it is a high-resolution softproof of the RIPped data, showing the actual rasterized job as it will 
be printed on the plate. The proof is shown in a web browser and includes a number of tools for 
easy viewing (zooming, rotation), color information, approval/rejection, measuring (angles, 
distance) and annotation comments. Colors can be viewed individually or together. 

To know more about View-it: 

Select Upload Only 
in PrePage-it Web’s 
Pages tab. 

Select Upload Only 
in PrePage-it Upload 
module. 

Click the Delete link to remove 
all selected (checkmarked) files. 

Select Job folder. 

or 
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• watch a quick video tutorial directly from the Polkadots web site 
http://www.polkadots.ca/support/training_videos.asp 

• consult the View-it 3.0 Help page by clicking the (Help) link from inside the View-it 3.0 window 
 
Preview 

Clicking the Preview toolbar button will show quick, low-resolution previews of all selected 
RIPped pages. These previews can be downloaded or saved to your hard disk by clicking the 
Download button from inside the Preview window. A zipped file will be created containing a TIFF 
or JPG preview of each selected page. 

View modes 

 

Job pages can be viewed in one of the following modes, as selected in the View By dropdown 
menu (shown above): 

• View by Icon 

• View by List 
 
View by Icon shows the thumbnail preview of pages. You can change the size of the thumbnails 
by clicking one of the [A] links. 

View by List displays information about pages without showing any preview. Information includes 
original filename, page size, colors, etc. This view allows you to list many more pages at once. 

Job Filter 

The Job Filter helps you to quickly find a job when your Job List has become too long to scan 
through visually. 

 

 

 

In the Filter box found at the top of the Job List window, you can filter out the job list by typing 
all or part of a job name. After typing the filter characters, press Enter (on keyboard) or click the 
Arrow button. 

a. type all or part of  
the job’s filename 

b. click Arrow button 
or press Enter key 

http://www.polkadots.ca/support/training_videos.asp�
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It will filter the job list down to only those jobs containing the specified filter characters 
anywhere in the job name. 

To return to the full job list, empty the Filter box and press Enter. 

Selection of pages 

Here is a list of techniques for selecting pages in Send-it: 

• You can select multiple adjacent pages by clicking inside a page and dragging the mouse 
across all other desired pages. You can also deselect pages in the same way. In addition, 
this procedure can be repeated in order to select several “groups” of non- adjacent pages 
inside the same job e.g. p.4-7, 12-19, 22-26. (Icon View only) 

Note 

Please note the selection procedure described above (i.e. dragging across pages) is not 
supported in Internet Explorer, only in Firefox and Safari. 

• You can select a list of consecutive pages by (i) clicking on the first page and (ii) 
Shift+clicking the last page you wish to select. (List View only) 

• You can select a page while automatically deselecting all other selected pages. To do so, 
middle-click or Shift+click a page. (Icon View only) 

• You can click the Select All toolbar button. (Icon & List View) 

• You can click individual pages. (Icon & List View) 
 

Tip 

Pages can be deselected in exactly the same way as they are selected. 

External User Accounts 
Some external customers/suppliers have more than one employee in their company who uploads 
pages to Send-it and approves/rejects jobs. To manage this, employees of an external supplier 
may be attributed a Super-User account or a User account. 

Suppliers that have a Super-User account can create additional User accounts for employees of their 
own company, for example, one account per employee. Alternatively, a supplier with multiple 
employees can have everyone submit pages to Send-it and approve/reject jobs using the same 
Super-User account. To decide which of these two setups would be more suitable for a given 
supplier, the following factors should be considered: 
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• Send-it will keep a record of the main actions taken by each user account. That is, every 
time a file is submitted/approved/rejected, the records will show the filename, 
timedate stamp and username for each action taken by any user. 

• When logged in to Send-it with a Super-User account, you can create one or more additional 
User accounts - when logged in with a User account, you cannot create or manage other 
User accounts. 

 

Note 

Since Users cannot create or manage other user accounts, the Settings tab is only 
visible to Super-Users - not Users. The Settings window is where user accounts are 
managed. 

Super-Users 

The Super-User would typically be the supplying company’s prepress manager or person 
responsible for creating and submitting jobs destined to be printed at the main company’s 
printing press. 

A Super-User can do anything that a User can do, as well as a few other things. They can: 

• create Users 

• list/softproof/approve/reject job pages from their own user group (i.e. jobs submitted by 
themselves or a User they have created) 

• list and submit files to Pages and Upload Only queues (except hidden queues) 
 
Users 

Users, unlike the Super-User, cannot manage user accounts. Also, a User can only see their own jobs 
- other User’s jobs are inaccessible. 

They can: 

• list/softproof/approve/reject only their own jobs (i.e. pages) 

• list and submit files to Pages queues and Upload Only queues (except hidden queues) 
 
How to manage external user accounts 

A Super-User can create and modify Send-it user accounts for their own employees (i.e. Users). 

To create a new User: 
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1. In the Settings tab, select Add New from the dropdown list. 

  

2. Specify the required User information: 

 

a Login, Password and Confirm are required. Full Name and Description are optional. 
b Class is determined automatically - it cannot be changed manually. 
c Click the Add button. 

 
To modify settings for a User: 

1. Select a User from the dropdown list. 
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2. Make the required changes and click the Modify button. 

Note 

To remove a user, select the user from dropdown list and click the Delete button. This 
will delete everything associated with the user, including jobs on the hard disk (see 
figure below). 

 

 
User groups 

A User Group refers to a “user” and all others below him in the user hierarchy, as illustrated in the 
examples below. 
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Owner 

If you want a job that you are creating to be visible and accessible to a particular user, then select 
them as Owner. 

You can designate someone as the owner of a job when you create a new job (see figure below). 
In addition, you can make the job visible to every user under the owner (i.e. his entire user group) 
by checking the box Make this job visible for the entire group. 

 

Troubleshooting Tips 
This section includes some basic troubleshooting tips in a question and answer format. 

  

User Group medjournal consists of: 
-medjournal (super-user) 
-Larry (user) 
-Dr Smith (user) 

User Group acmeprint consists of: 
-acmeprint (super-user) 
-Pierre (user) 
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Refresh / Reload a web page 

F
I
R
E
F
O
X  

 

S
A
F
A
R
I 

 

 

I
N
T
E
R
N
E
T 

 
E
X
P
L
O
R
E
R 

 

 

Reload button or 
CTRL+R (PC)or 
Command+R (Mac) 

Refresh or F5 (PC) 

Reload button or 
Command+R (Mac) 
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Q: If portions of the Send-it interface are displayed incorrectly or missing? 

A1: Try to Reload/Refresh the web page. Web browsers generally have a Reload or Refresh 
command (see previous figure). 

A2: If this doesn’t work, try erasing the web browser’s cache and then Reload/Refresh the web 
page. Try this, for example, if you notice a display problem occurring after a software update. 

To clear the web browser’s cache: 

• Firefox: click Tools > Clear Private Data or Clear Recent History 

• Safari: click Safari > Reset Safari 

• Internet Explorer: click Tools > Internet Options > Browsing History > Delete 
 

Q: Some windows are not opening when you click a link in the Send-it Client? 

A1: Make sure you are using recent versions of web browsers. 

A2: Pop-up blockers can prevent some Send-it windows from being displayed – try de-activating 
them. 

A3: Avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.). 
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